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Overview of Documentor

You can use the Documentor to design and produce documentation for the system you are
designing. With this tool, you can:

¢ Design your document format.

¢ Determine what kinds of information to include in it.
Your documents can include textual and graphical information from avariety of sources, including
your project database and external files and programs outside your workarea.

You can use the Documentor in conjunction with the Reports tool. Whereas the Reports tool enables
you to produce predefined reports, the Documentor enables you to produce reports customized for your
specific needs.

This section presents an overview of the Documentor tool. The topics are as follows:

¢ Basic Concepts
¢ Designing a Document Using Templates
¢  Documentor Interface with Formatting Systems

Basic Concepts

You can use the Documentor to design formatted reports that combine information from the
following sources:
+ System-under-design (SUD) database retrievals
+ Reports produced by the Reports tool
¢ Plotsof charts produced by the Plots tool
+ Externdl files (referred to asinclude file3 that can contain text, tables, figures, and so on
+ Information produced by external programs
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The following figureillustrates internal and external sources, and the process of final document
production. Note that non-shaded areas represent facilities outsideof the system.

external text

programs files Extraction

Functions

document segments
temp. processing el

Template Output the text file (can include formatting

commands
Format
Processor
Output — Final
— | Device Document
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Basic Concepts

Document Generation Language (DGL)

You design your documents by writing a program using the Document Generation Language
(DGL). Thislanguage provides you with grest flexibility in designing your document. Among other
features, DGL enables you to extract information from your project database (workared).

DGL Template

The document design program that you write using DGL is called atemplate Thetemplate contains
ingtructions asto what information isto beincluded in the document. It can aso include formatting
ingtructions to be passed to a document format processing system, called aformatter Formatting
instructions specify components within your document, including:

¢ Text width

¢ Margins

¢ Headersand footers
¢ Pagination

DGL Segments
Thetemplateis divided into sections called segmentsTo generate the document, you execute the
template. Each segment of the template produces a separate text file called adocument segment

Creating a document in segments is more efficient than producing an entire document. By using
segments, you can produce the document in stages, updating or editing the segments as needed.

Note

The division of the template into segments does not necessarily have to correspond to the
final document divisions (chapters, sections, and so on). However, it isagood ideato have
the template segments correspond with document divisions wherever possible.

Document Assembly
The Documentor assembles the generated document segments, then does one of the following:

¢ Exports the segments to an external output device or file.
¢ Sendsthe segments to a formatting system to produce the final document.
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Designing a Document Using Templates

The following example shows a document that consists of the following:

+ Title
¢ Overview, which containsintroductory information from an external text file
¢ Plot of an activity-chart

¢ Property information on subactivities shown in the chart, consisting of a property report
from the Reports tool

The following figure shows the formatted report.

page 1
Description of MEASURE

Chapter 1: An Qverview

This document describes the system

pagen o page n+1
Chapter 2: System Activities 2.2 Activities Description

2.1 Activity-Chart Detailed description of each activity inthe

Thisisthe chart that describes the ac-
ACTIVITY PROPERTY

CALIBRATE
CONTROL | This activity determines...............
SET_UP
|CALIBRATE | Y This activity getsvalues...............
[ compare

COMPARE
SET_UP This activity compares the values
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Designing a Document Using Templates

Generating the Document

Thefirst step isto create the template needed to generate the desired document using DGL.
Because the document contains information about a particular activity, you can use aDGL
parameter called act_nameYou specify the value of the parameter (in this case, the activity name for
which you are producing the report) when you are ready to generate the document.

Formatting Commands

Some of the commands in the template consist of formatting instructions to be interpreted by the
formatter used to produce the final document. This example uses an abstract formatter, rather than
a specific one.

The following table lists the commands used by this example.

Command Description
.skip<n> Outputs n blank lines
.center <title> Centers the specified title on the line
.Chapter <title> Starts a new chapter with the specified title
.section<title> Starts a new section with the specified title
.page Starts a new page
literal and .end literal Outputs the block of text specified between the

keywords .literal and .end literal

Sample Template

In atemplate, statements beginning with - -” are comments and are not interpreted by the tool.
Formatting instructions and other text written between the /@ and @/ markers are passed to the
output filesverbatim

The example uses the following template:

TEMPLATE example;

-- Initiation (global) section

PARAMETER

STRING act_name; -- activity for which

-- the report is written

VARIABLE

ACTIVITY act_id; -- id of “act name”

INTEGER st; -- status return code
BEGIN

act_id := stm_r ac (act_name, st);
END;
SEGMENT segl; -- contains chapter 1 of the document
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BEGIN
/@
.page
@/
WRITE (’.center Description of ’,act name);
/@
.chapter An Overview
@/
INCLUDE (’sys_overview’); -- an include file containing
-- text with formatting commands

END;

SEGMENT seg2; -- contains chapter 2 of the document

VARIABLE
LIST OF ACTIVITY ac_list;

BEGIN
/@
.page
.chapter System Activities
.section Activity-chart
.skip
This is the chart that describes the activities
of the system:

e/

stm plt(act_id, ....); -- Activity-chart plot

/@

.page

.section Activities’ description

.skip

Detailed description of each activity in the chart:

@/

ac_list:=stm r ac_logical sub of ac({act_id},st);

stm_rpt dictionary(ac_list,....); -- property report
END;

Template Sections

The example template is divided into three parts:

¢ [Initiation section—Extracts the activity ID number (act_id)from the database. This number
isused later in the template to call the appropriate activity-chart plot and to extract the
subactivitiesfor the property report.

¢ SEGMENT segl—Containsinstructionsto produce the title of the document and chapter
1. Inthis case, chapter 1 istext contained in an includefile, sys overview.

¢ SEGMENT seg2—Contains instructions for producing a plot of an activity-chart and a
property report of subactivities.
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Executing the Template

After the templateis created, you execute it. As part of this process, you enter the value for the
parameter act_namen a special form provided by the tool. (In this example, the value for the
parameter is the activity’s name, MEasure.) Asaresult of specifying the activity name, the
appropriate information for the activity measure will be included in the document.

The Documentor produces separate text files, corresponding to the segment sections specified in
the template. These filesinclude:

+ Information generated from the project database (the activity-chart plot and property
report).

¢ Text from anincludefile.
¢ Formatting instructions.

Formatting instructions and other text written between the /@ and @/ markers are passed to the
output files verbatim.

If you have made any errorsin your template, error messages are displayed during the execution
phase. Correct the template and then re-execute it.

Output Files

After executing the template for the activity MEasure, the resulting output files (document
segments) resemble the following:

DOCUMENT SEGMENT SEGI:

.page

.center Description of MEASURE

.chapter An Overview

text and formatting commands as written in the file ‘'sys overview’

DOCUMENT SEGMENT SEG2:

.page

.chapter System Activities

.section Activity-chart

.skip

This is the chart that describes the activities of the system:
.literal

plot information to be sent to the printer

.end literal

.page

.section Activities’ description

.skip

Detailed description of each activity in the chart:

Output of Report Tool for the Property Report, including formatting commands for
the specific formatter.
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Final Assembly

Once the segments are generated, you can use various Documentor options to edit or regenerate
them.

When you are satisfied with the segments, you can copy them to an external file or format them.
Both of these operations automatically assemble the segments into onefile.

The Format option assembles the segments and passes them to the format processor that you specify
when you cregte the template. The format processor interprets the formatting statementsin the file and
produces afinad document that is completely formatted.

Reusing Templates

You can generate different documents from the same template using parameters within the
template. By changing the values of these parameters, you can change the information that is
written, while maintaining the overall structure and format of the document.

For example, the template produces a plot of an activity-chart and a property report for the activity
MEASURE. |nstead of writing the name mMeasure directly into the template, the template uses the
parameter act_name. Thisway, you can specify the name of the activity in aform at the time of
template execution.

You can use the template repeatedly, specifying adifferent activity name each time you execute the
template. This enables you to produce uniform reports for as many activities as desired.

Include Files

You can include files outside of your project database within your documents. In the template
example, theintroductory sys overview Section isnot part of the database, but is an external file.
You can create such files while you work with the Documentor, or you can copy them from outside
your workarea. In the example, thisfileis assumed to already bein the workarea. Therefore, thefile
path is not specified—only the file name. Thefileis accessed viathe 1ncrLupe statement within the
template and inserted in the segment files when the template is executed.

The same include files can be used in a number of different documents, and can be called from a
number of different templates.

The figure illustrates the relationship between templates, include files, and parameters, and the
segmentsthat are produced after the templates are executed. Template A contains parametersand is
generated twice—once using set 1 of the parameter values and once using set 2.

Using the first set of parameter values, the segments of document a1 are generated. In addition,
template a contains a statement calling an external include file, 71, into the generated document
segments of AL
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When the second set of parametersis used, the segments of document a2 are generated. Again, the
include file r1 isincluded in the output segments.

Template B is used to generate the segments of document B1. These segments contain two include
files: r1, which was also included in the segments of document a1, and a separate includefile, r2.

set 1 of parameter values Segments of
Template A include File F1
Segments of
set 2 of parameter values
Template B > Segmentsof  [————

include File F2

File Access

The Documentor files, templates, and include files used for document generation are stored in your
workarea. You create and edit these filesin your workarea using the Documentor.

You can store your templates and include files in the databank so they can be shared with other
project members, and for version management purposes. In addition, you can export these files
from, and import these files to, outside of the system using standard storage functions.

There are templates and include files used to generate standardized documents within a company
(or even within an industry) whose use is independent of any particular project. These common
files must first be imported to your workarea either directly or via the databank.

Standardized templates, such as templates for the DOD-STD-2167A document set, can be
supplied with Rational Statemate. You can import the templates to the project databank when the
project is created, or select File > Import in the workarea browser.

The resulting segments and documents that the tool creates are not stored in the databank, but
reside in your workarea. These are handled the same way as other stored files on your system.
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Documentor Interface with Formatting Systems

When you create atemplate, you can assign aformatter to it from a predefined list (for example,
Interleaf).

Embedding Formatting Instructions

You can embed formatting instructions in a template. Upon execution, these instructions are
passed verbatim to the output segments. When these segments are assembled and sent to a
formatting processor, the instructions are interpreted and afinal, formatted document is produced.

You can embed formatting instructions for any kind of formatting system or word processor. Some
systems are interactive in nature; that is, you do not directly see the formatting instructions used by
the system when working with it.

If you are working with such a system, you must first determine the particular language (set of
instructions) that can be used by the system in batchmode. These instructions can then be embedded
inthe template in the same way asfor any other formatting system.

Predefined Reports

Plots

In many documents, you might want to include areport generated from the Reportstool. The
formatting of reports and plots depends on the formatter used and whether this formatter is
supported by the system.

Reports from the Reports tool are textual. They have predefined formats determined by embedded
formatting instructions. For example, assume that you write a template that calls areport (such as
the property report in the sample template), and that you are working with a supported formatter.
When you execute the template, the Reports tool automatically embeds the formatting instructions
appropriate for the attached formatter within the generated report. This means that the report that
appearsin the resulting output segments contains embedded formatting commands. Passing the
files to the designated formatter results in a document displaying the report in its predefined
format. For more information on reports, see INCLUDE.

The Plots tool can generate graphical instructionsin several languages. These instructions can be
addressed to a printing (plotting) device or to a specific formatter that supports graphics.

For example, the plot in the sample document was included in the document by using afunction
call stm_p1t. Oneof the parameters of thisfunction isthe graphica output language. You can passthe
attached formatter’s language as a parameter to a plot function as long as the formatter can handlea
graphical language. In this case, the formatting system processesthe plot as part of the entire document.

10
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If you are working with aformatter that cannot process graphical information, you can generate
the plot in the language of the output device (printer or plotter) and instruct the formatter to pass
the information without processing it. Alternatively, you can produce a separate plot file and later

merge the plot into your final document. For more information on plots, see INCLUDE.

Note
Plots created using the Word format in the Output Device dialog box are RTF files.

Invoking a Formatter from Within the Documentor
There are two ways to send segment files to a formatter for final processing:

¢ Export the filesto an external file (the export operation automatically assembles the
segments into onefile). You then invoke the formatter on the file that you want to format
as you would for any other text file.

+ For severa formatting systems, you can choose the For mat option. Thisoption
automatically assembl es the segments and sends them to the formatter without requiring you to
exit from the Documentor.

Note

The Format option is available only for specific formatters, such as nroff. Interleaf, which
is an interactive formatting system, cannot be activated from within the Documentor tool.
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Using Documentor

This section describes how to use Documentor in detail. It includes:

+ Descriptions of Documentor menus and dialog boxes
¢ Step-by-step procedures for each Documentor option

Thefirst part of the chapter provides an overview of operations, including how to start the
Documentor and the connection between the stages of document production and the different tool
options. Use this section to locate the menus that you need to perform a particular operation.

The second part of the chapter explains how to perform Documentor operations.

Document Production Process

There are four stages of document production:

Document Production Menu Option

Writing the template Edit > Templates
Creating new templates and editing, deleting, copying, exporting, compiling,
and printing existing templates.

Preparing include files Edit > Include File

Creating new include files and editing, deleting, copying, exporting, and
printing existing include files.

Producing document segments Edit > Documents
Generating new document segments.

The Documentor enables you to regenerate particular segments without
having to regenerate the entire document. If you are not satisfied with a
segment, you can edit it before producing the final document.

Producing the final document Edit > Documents

Regenerating and editing document segments. Deleting, exporting, printing,
and formatting existing documents.

If the segments do not contain formatting instructions for a particular formatter,
you can print the files directly. If the segments contain formatting instructions,
you send them to a formatter. This involves either sending the segment files
directly to a formatter, or copying them to an external file and formatting them
outside of the system.
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Starting Documentor

To start the Documentor from within the system:

1. Start asession and open a project.

2. Click the Documentor % icon in the Rational Statemate main window. The Document

-
L

Management window opens.

In addition, the Document Management dialog box opens simultaneously so you can
easily manage your documents (see Creating and Manipulating Documents).

Producing the Document Template

A document template consists of statements (instructions) writtenin DGL. A templateisatext file
containing instructions for document generation. In principle, you can create atemplate in the
same way that you create a source file for any other programming language. For simplicity,
template files are handled from within the system by standardized storage functions.

Creating and Manipulating Templates

To work with templates, select the Template @| icon in the toolbar or Edit > Template from

the main menu. The Template Management dialog box opens. In the dialog box, the Templates
table lists the available templates in your workarea.

Creating a Template
To create atemplate:

1. Click New. The New Template dialog box opens.

2. Enter aname for the new template in the Name field. The template name must begin with
aletter, and can contain only a phanumeric characters or underscores.

The name must be unique in this project. If you select different formatters, you can use
the same name for multiple templates because the system appends the formatter type to
the name you enter, thus making the names unique.

For example, if you enter the name PAGER and select FrameMaker as the formatter, the

system names the template PAGER_FRM. Thefollowing table lists the extension for each
formatter.
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If atemplate with this name already exists, the Documentor displays awarning. You can
cancel or confirm your choice to overwrite the old template. To modify an existing name,
click on the cascade button and select a name from the list of templates. This placesthe
name in the Name field so you can then modify it.

FrameMaker _FRM
Glyph _GLP
Interleaf _IFF

troff _TFF
Word _RTF
Undefined _OTH

3. Select aformatter from the list of supported format processors.

The format processor operates on the formatting instructions entered into the templ ate.
(See Overview of Documentor for more information.) When you copy an existing template,
the formatter type for the new template is the same as for the original, unless you specify
otherwise.

4. Click OK. Thetext editor opens.
5. Write your template using DGL statements.

6. To saveyour template, select File > Save, then File > Exit. to close the text editor. You
return to the Template Management dialog box.

You can also create a new template by copying an existing template and editing it as needed.

Editing a Template

To edit an existing template:
1. Select the template from the list in the Template Management dialog box.
2. Click Edit. The template opens in the system’s text editor.

3. Make your changes, then select File > Save and File > Exit in the text editor.
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Deleting a Template

To delete atemplate:
1. Select the template from the list in the Template Management dialog box.

To delete multiple templates, hold down the CTRL key when making your selections.
2. Click Delete.
3. The Documentor prompts you to confirm the deletion. Answer Yes.

Thetool first checks for documents that were generated using the template. If it finds any, the
template is not deleted and a list of documents that were generated from the template is displayed
in the main window. The Documentor tool assumes that you need to keep the template sources
from which existing documents were made. You must del ete those documents before their
associated templates can be deleted.

16
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Copying a Template
To copy atemplate:

1. Select the template from the list in the Template Management dialog box.

2. Click Copy. The Copy Template dialog box opens with the name of the template in the
title bar.

3. Typeanew name for the template copy.

4, Select OK. A copy of thetemplate is displayed in the Template Management dialog box.

Exporting a Template

To export atemplate:
1. Select the template from the list in the Template Management dialog box.
2. Click Export. The Export Files dialog box opens.
3. Click OK to export the template and dismiss the dialog box.
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Compiling a Template

You can check atemplate for adherenceto DGL syntax rules using the Compile option. Thisisthe
same as program compilation in other languages. Use this option to see whether atemplate is
executable, without actually performing the execution. Any errors are logged so you can execute
templates unattended.

Note

If you do not compile your template, the tool checks the template for errors upon execution
(see Creating a Document).

To compile atemplate:
1. Select the template from the list in the Template Management dialog box.

2. Click Compile. A message is displayed in the main Documentor window that notifies you
whether the compilation was successful.

If there are compilation errors, a message notifies you that errors were found. The error messages
are written into the template in the form of comments. A compiler error message appears as close
as possible to the line where the problem was found. The following example shows atemplate
with error messages:

name := stm r st name (state chart, status;
--%$DOC (E1352) Missing ')’

name := name + 5;

--%DOC (E1142) Argument mismatch

name := nm;

--%DOC (E1211) Identifier NM not declared

FOR sub_state IN sub_list LOOP
i:=i+1
--%DOC (E2001) Missing ' ;'

You must correct template errors before re-executing the template, but you do not need to remove
them from the template file. The Documentor automatically removes them the next time the
template is compiled or executed.
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Printing a Template

To print atemplate:
1. Select the template from the list in the Template Management dialog box.
2. Click Print.

To print multiple templates, hold down the CTRL key when making your selections.

Using Include Files

Your document might include files external to the specification database. Such includefiles consist
of textual explanations, diagrams, pictures, and so on. Insert these filesin your document using the
INCLUDE Statement in the template. When you execute the template, the include files are copied
into the resulting document segments.

Creating and Manipulating Include Files

To add includefiles, click the Include Files‘ ﬁ,:_‘_‘l| icon in the main Documentor window, or select
Edit > Include File. The Include Management dialog box opens, as shown in the following figure.

il

Include Files |

STO_TEMFLATE_RTF New. ..
Edit |
Delete |
Copyes. |
Export... |
Print |

Dlizmizz | Help |

The dialog box lists the include filesin your workarea.
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Creating an Include File

To create an include file:
1. Click New. The New Include File dialog opens.

New Include File | x|

Include Files
STO_TEMPLATE_RTF

Iﬂ_c:_l}ude File Mame

0K | Eancell Help |

2. Enter aname for the new include file in the text box. The include file name must begin
with aletter, and can contain only alphanumeric characters or underscores.

The name must be unique in this project. If an include file with this name aready exists,
the system displays awarning. You can cancel or confirm your choice to overwrite the old
include file. To modify an existing name, select a name from the list and modify it in the
text box.
3. Click OK toinvoke the system’s text editor where you can create a new includefile.
Alternatively, you can create anew includefile by copying an existing include file and editing it as
needed.

Editing an Include File
To edit an includefile:

1. Select theinclude file from the list in the Include Management dialog box.
2. Click Edit. Theinclude file is displayed in the system’s text editor.

3. Make your changes, then select File> Save and File > Exit in the text editor.
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Deleting an Include File

To delete an include file:

1

Select the include file from the list in the Include Management dialog box.
To delete multiple include files, hold down the CTRL key when making your selections.

Click Delete.

The Documentor prompts you to confirm the deletion. Answer Yes.

Copying an Include File

To copy an includefile:

1
2.

3.
4,

Select the include file from the list in the Include Management dialog box.

Click Copy. The Copy Include dialog opens with the name of theinclude filein thetitle
bar.

Type a new name for the include file copy.

Click OK. A copy of theinclude fileis displayed in the Include Management dialog box.

Exporting an Include File

To export an includefile:

A 0w P

Select the include file from the list in the Include Management dialog box.
Click Export. The Export Files dialog box opens.
Type the directory and file name where you want to export the include file.

Click OK to apply your changes and dismiss the dialog box.

Printing an Include File

To print an includefile:

1
2.

Select the include file from the list in the Include Management dialog box.

Click Print.

To print multiple include files, hold down the CTRL key when making your selections.

Rational Statemate
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Producing the Document Segments

After writing the template and preparing any include files to be included in the document, you are
ready to execute the template and generate the unformatteddocument segments. Each segment file
contains information from various sources that you specified through the DGL statements in your
template.

The Documentor permits file operations on segments independent of the sources from which they
were generated. These operationswork in the same way for both for templates and includefiles.

This section describes how to use the following options in the Document Management dialog box:

+ New—Generates segments for a new document
¢ Edit—Modifies any of the generated segments
¢ Delete—Deletes a document

+ Regenerate—Regenerates specific segments of the document without re-executing the
entire document.

For information on the Export, Print, and For mat options, see Producing the Final Document.

Creating and Manipulating Documents

To work with documents, click the Documents 3%; icon in the toolbar or select
Edit > Documents from the main menu. The Document Management dialog box lists the
documentsin your workarea.
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Document Management = |EI|5|

Documents |
REAR_TEFOG

Mew, .,

bt I
Delete I
Export, .. I
Regenerate...l
Print,.. I
Format. . . I

Dizmizsz | Help I

Creating a Document

To create a document:

1. Click New. The New Document dialog box opens.

x
Hame? I j
Template: ISTD_TEHF‘LHTE_RTF j

0k I Cancel I Help I

2. Enter anamefor the new document in the text box. The name must begin with aletter, and
can contain only alphanumeric characters or underscores.

The name must be unique in this project. If a document with this name already exists, the
system displays awarning. You can cancel or confirm your choice to overwrite the old

document. To modify an existing name, select aname from the drop-down list and modify
it in the text box.

3. Enter the name of the template you want to execute, or select it from the list of templates.

Rational Statemate
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4. Click OK.

The Documentor checks the template for errors. If there are compilation errors, the tool
displaysawarning. Y ou must correct all the errors before you can generate any segments.
See Creating a Template for moreinformation. When | of the errors have been resolved, click
New again.

If there were no errors, the Generate Document dialog box opens, as shown in the figure.
This dialog box enables you to select all or some of the template segments and enter
values for the parameters to be used when generating the document.

The Generate Document dialog box contains two tables:

a. Parameter Name—Displays the current parameter values. If you assigned initial
valuesto the parametersin the template, these values are displayed in the Parameter
Value column. If you change these values, the new values are stored and displayed
prior to any regeneration of the document segments. (For more information, see
Regenerating Document Segments.)

b. Segment Name—Lists the document segments, all of which will be generated by
default (see the Yesvaue in the Gen column). If you do not want to generate a
specific segment, click on the Yes next to that segment and the field changes to No.

By default, the view is collapsed so the segment information is not displayed. Click
Expand to expand the view.

Regardless of the template segments that you select for execution, the initiation
section of the template is always executed. See Overview of Documentor for an
explanation of template segments.

5. Enter valuesfor the relevant parameters shown in the form. (For more information on
template parameters, see Reusing Templates.)

6. Click OK to apply your changes and dismiss the dialog box.

Thetool generates the segments and the new document name isincluded in thelist in the
Document Management dialog box.
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Generate Document REAR_DEFOG_SS i

Generate Document Dialog Box (shown expanded)

x|

Parameter Mame

||Parameter Valug

TOP_CH_MAME
HERDER_TEXT
WORD_DEWICE
HFGL_FLOTS
ID_LOMG_DESC
COVER_PAGE
DOC_TITLE
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REYISIOM_DATE
DOC_AUTHOR
APFLICABLE_DOCS
SYS_OWERWIEW
TREE_MODE
TT_COL_WIDTH
TT_OLD_STYLE
INS_EXT_FILE
GEM_TR_TABLES
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CHG_LOG_BY_DATE
CHG_LOG_ALL_CH
WITH_HYPER

¥ Collapse

ACTIMITY _CHART_TEST

WORD
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ehopking

TRUE
1000
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COVERPAGE Yes
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FUMCTIONS Yes
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PROC_AND_GEN Yes |

0K |

Cancel |
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Editing a Document

After generating the document, you can edit any of the generated segments. The Edit option
enables you to make minor changes in a generated document segment, without having to edit and
re-execute the entire document template.

To edit a document segment:

1. Select the document from the list in the Document Management dialog box.

2. Click Edit. The Edit Document dialog box opens, as shown in the following figure.

3.

Edit Document REAR_DEFOG x|

Seqnent.s =]
COVERPAGE

HIR_FTR_TOC

DOCUMENTS

SYSTEM_OVERVIEL

FUNCTIONS

CONT_CH

GEMERIC_ACT_CH =
FUNCT LOMAL _DESC

PROC_AND_GEN

BEHAVIORAL _DESC

DICTIOMARY =

Ok I Eancell Help |

Select the segment you want to edit.

4. Click OK. The segment opens in the system’s text editor.

5. Make your changes, then select File > Save and File > Exit in the text editor.

Deleting a Document

To delete a document:

1

Select the document from the list in the Document Management dialog box.

To delete multiple documents, hold down the CTRL key when making your selections.
Click Delete.

The Documentor prompts you to confirm the deletion. Answer Yes.
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Regenerating Document Segments

The Documentor enables you to regenerate particular segments of your document without re-
executing the entire template. After generating some of the document’s segments, you might want
to go back and generate other segments that you did not originally select. Perhaps you altered the
template or changed your specification. You will need to regenerate those segments affected by the
modifications.

Using the New option for thistask is inefficient. When you create a new document, any previous
segments for the document are erased, then the specified segments are generated. Thisiswhy
Documentor provides an additional document operation, Regener ate. This option allows you to
redo particular segments, without affecting existing segments of your document.

To regenerate a document segment:
1. Select the document from the list in the Document Management dialog box.

2. Click Regenerate. The Regenerate Document dial og box opens.
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Regenerate Document REAR_DEFOG _ ﬂ
Parameter Mame ||Parameter Walue "
TOP_CH_MAME ACTIVITY_CHART _TEST
HERDER_TEXT
WORD_DEYICE LORD
HPGL_PLOTS FALSE
TD_LOMG_DESC TRUE
COVER_PAGE
DOC_TITLE
SPEC_REYISION
REWISION_DATE Tue Apr 23 09:50134
T0C_AUTHOR ehopkins

APPLICABLE_DOCS
SYS_OVERMIEW

TREE_HODE TRIE
TT_COL_WIDTH 1000
TT_OLD_STYLE FALSE
IMS_EXT_FILE TRLE
GEM_TR_TABLES TRLE
WITH_LAEELS TRIE
CHG_LOG_BY_TIATE TRLE
CHG_LOG_ALL_CH TRLE
WITH_HYPER TRIE

| | Expand

oK | Cancel | Help |

3. By default, all segments are selected. Unselect the segments that you do notwant to
regenerate by clicking on the Yes next to it; the field changesto No.

You can change parameter values. However, changing the parameter values can be
problematic when regenerating segments. It is usually undesirable to have some segments
generated with one set of parameter values, and other segments created with a different
parameter set. If you ater some parameters and regenerate a portion of your document,
the Documentor asks you to confirm the regeneration.

4. Click OK to apply your changes and dismiss the dialog box.
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Producing the Final Document

After generating the document segments, you output them as an assembled finished document. If
the document segments contain formatting instructions, you send them to a formatter to produce
the final document.This procedure also depends on whether the Documentor can invoke the
formatter. For example, Interleaf cannot be activated from within the Documentor.

Select one of the following three ways to produce the final document depending on your formatter:

¢ For ASCII and PostScript files, use Print.
¢ For FrameMaker, Interleaf, Word, and troff files, use Export.
¢ For Glyphfiles, use Format.

Printing a Document

Use Print for document segments that do not contain formatting instructions (such as ASCII and
PostScript) that you want to send directly to your local printer. This option isaso useful for shipping a
document in amachine-readable format to another site.

To print adocument:
1. Select the document from the list in the Document Management dialog box.

2. Select Print. The Print Document dialog box opens, as shown in the following figure.

Print Document REAR_DEFDG |
Seqnent.s =]
COYERPAGE

HIR_FTR_TOC

DOCUMENTS

SYSTEM_OVERYIEW

FUMCTIONS

COMT_CH

GEMERIC_ACT_CH —
FUMCTIONAL _DESC
PROC_AND_GEM
BEHAYIORAL _DESC
DICTIOMARY

I8

Cancel Help |
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3. Select the segments you want to print:

¢ Select one segment by clicking onit.

¢ Select multiple segments by holding the CTRL key.

¢ Do not select any segmentsto print all the segments.
4. Click OK to dismissthe dialog box and print the document.

Exporting a Document

Use Export for document segments that contain formatting instructions for formatters that cannot
be activated from within the Documentor (such as FrameMaker, Interleaf, Word, and troff).

To export adocument to an external file:

1. Select the document you want to export from the list in the Document M anagement dialog
box.

2. Click Export. The Export Document dialog box openswith the name of the document you
selected in thetitle bar. It lists all the generated segments for the selected document.

3. Select the segments you want to export:

¢ Select one segment by clicking onit.

¢ Select multiple segments by holding the CTRL key.

¢ Do not select any segmentsto export all the segments.
4. Click OK to dismissthe dialog box.

5. Enter the output file path name (using the operating system conventions for your host
computer). Thisisthe file destination for the output.

Note: You can also enter anew name by clicking on the ellipsis (...) to display the
Export Filesdialog box.

6. Click OK. Thetool assembles the segmentsin the correct order and writes them to the
specified destination.

7. Invoke your formatter on that external file.
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Formatting a Document

Use Format for document segments that contain formatting instructions for formatters that can be
activated directly from within the Documentor (such as Glyph).

To format a document:

1
2.

Select the document from the list in the Document Management dialog box.
Click Format. The Format Document dialog box opens.
Specify thefield values:

+  Select the segments that you want in your document.
+ Optionally, select additional output devices Terminal, Printer, or both.

+ Specify the output file path name. Thisisthefilethat contains the final document.
Thefileis produced by the formatting system.

Click OK. The Documentor assemblesthe segments, then activates the formatter to produce the
document.

Working with Different Formatters

Overview of Documentor explains the relationship between the Documentor and formatters. To use

any formatter, it must be present on your host computer. You can edit or generate Documentor files
on any computer running Documentor, but you can use the Format option only on a host that
actually runs the target formatting system.

Rational Statemate 31



Using Documentor

Using nroff and troff

nroff and troff are UNIX-based formatting systems.

nroff is atextual formatting system that prepares output for standard ASCII devices such as
terminals, disk files, and printers. You can activate nroff directly from the Documentor using the
Format option on templates attached to the troff formatter.

troff isa graphical formatting system that prepares output for laser printing devices. Despite the
difference, these systems are compatible in that troff can use nroff input files to produce fina
output. troff cannot be activated directly from the Documentor.

Note

+ nroff input requires preprocessing for commands used with equations and tables. If you
use such commands in your template or include files, you should not activate nroff
directly from the Documentor. The Documentor does not support preprocessing of output
before sending it to nroff.

+ If you run nroff externally, predefined reports generated by the Reports tool use the
macros library me.

For information on troff and nroff, see the UNIX system documentation for your computer.

Using Interleaf

Interleaf isadocumentation preparation system available on various computer systems. Because it
isinteractive, Interleaf cannot be activated directly from the Documentor. In addition, you must
make sureto includethefile interleaf glob inthefirst segment of your template. Thefileis
supplied as an include file in the databank. You must load this include file into your workarea for
Documentor to accessit. Thisfile contains global definitions that are used in Rational Statemate
reports.

For more information on Interleaf, see the Interleaf documentation provided with the formatter.
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A template is atext file consisting of instructions for generating a document. The instructions are
written in the Document Generation Language (DGL). This section, divided into three parts, explains
the fundamentals of DGL:

¢ Principles of DGL
¢ Dataitems and expressions

¢ Detailed explanation of DGL statements

Part one covers the basic concepts of DGL and shows you the general principles of template
writing. In part two, we discuss identifiers and the types of data they can represent. We also detail
the various kinds of expressionsthat you can usein DGL statements. In part three, we present each
DGL statement.

In your template, you can call functions that extract the information stored in the specification
database, and write thisinformation into your document. The use of Database Extraction Functions
iscovered in Qverview of the Extraction Functions.

Principles of DGL

DGL isastructured programming language and displays features typical of other structured
languages such as Pascal. Among these are: declarations for identifiers, the use of variables,
parameters and constants, and control flow statements. In this section, the principles and
conventions of DGL are introduced.

DGL Template Structure

Every template consists of two main parts:

1. Initiation section—Contains declarations and statements that pertain to the overall
template. It may not include output statements.

2. Template segments—Sections of the program, each of which pertains to a particular
portion of the document.
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TEMPLATE example I nitiation section

contains global declarations and
VARIABLE

CHART ch_id;
INTEGER status,

BEGIN

ch_id :=stm_r_ch (‘CHZY’ status) ;

SEGMENT seg 1; segment
contains local declarations and
VARIABLE
STRING fn:='/tmp/my_file’;
BEGIN
INCLUDE (fn);

TEMPLATE example I nitiation section

contains global declarations and
VARIABLE

CHART ch_id;
INTEGER status,

BEGIN

ch_id :=stm_r_ch (‘CHY’ status) ;

SEGMENT seg 1; segment
contains local declarations and
VARIABLE
STRING fn:="/tmp/my_file’;
BEGIN

INCLUDE (fn);

Template segments are the basic divisions of the document and, when executed, produce distinct
output files called document segmentbese are later assembled into the final document. The segments
do not necessarily correspond to the document divisions (i.e. chapters, sections, etc.). However, we
recommend that you divide the segments according to such divisons. This givesyou the ahility to
generate separate sections or chaptersindividualy; the initiation section, however, is executed whenever
any segment is executed. See the discussion on Template Sections for more information.
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Theinitiation section and template segments all have the same overall structure:
1. Identifier line- (Required) Identifies the entire template or template segment by name.

2. Declaration part - (Optional) Contains the definitions of any constants, or variables used
by the template section during execution. Identifiers declared in the initiation section are
global, i.e., they may be used throughout the template; in the initiation section (only) you
may include parameter declarations, as well as variables and constants.

3. Body - (Required) Contains execution statements. The body is composed of aBEGIN/END
statement that delineates the section’s statements. Any number of statements may be
found in the body. The initiation section may not include output statements.

SEGMENT seg 1; identifier line
declaration part
VARIABLE contains local declarations
CHART ch_id;

INTEGER status;

body
contains DGL statements
BEGIN

ch_id:=stm_r_ch (‘CHZ1 ,status); stm_plot
(ch_id, ‘my_file’, ...);

DGL Syntax Rules

DGL, like most programming languages, has a particular syntax that must be obeyed. The full
syntax of each DGL statement is given in DGL Statement Reference. A more formal DGL syntax,

written in BNF, is provided in BNF Syntax.

Thefollowing isalist of general syntax rulesthat apply to all DGL statements:

1. DGL isnot case sensitive. The exception to thisruleisliteral strings (inside apostrophe
marks). These are utilized exactly asthey appear in the template.

2. DGL statements terminate with a semicolon.
3. Multiple statements on a single line are permitted.

4. A single statement may span several lines.
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DGL has a set of reserved words and syntactical constructs. Each of these has a special
meaning and can be used only in the context for which it has been designed. The DGL
reserved words are listed in DGL Reserved Words.

Anidentifier (a name you assign to an object for identification purposes) can be any
string, beginning with aletter and consisting of any of the following characters: A-Z, &z,
0-9, _. Reserved words may not be used asidentifiers.

Literal strings may be assigned by enclosing them within apostrophe marks (' ). Any
character sequence can be used inside literd strings.

Comments are preceded by adouble dash (- - ) symbol. This symbol can be placed anywhere
in the line except within alitera string. After the comment symbal, al other characterson the
lineareignored.

Extra blank spaces within or between statements are ignored.

statements terminate with

SEGMENT seg 1;

asemicolon.
VARIABLE
chArt ch o identifier can be any
not case sensitive - string beginning with
INTE- status; aletter and consisting

of characters A-Z, 0-9, _

ch_9:=stm_r_ch single statement may span two

(‘CHY1 , status) ; lines.
BEGIN
WRITE (* This is a Plot ' ); ————itera stringsenclosed in
apostrophes.
STM_PLOT_ (ch_9, ‘my file, ...);
. . —comment lines preceded by a
END; -- thiskeyword ends double dash.
-- this section

extrablank spaceswithin state-
ments or between statements
areignored.
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Special Features of DGL

We mentioned before that DGL resembles other structured programming languages. DGL also
includes specia constructs and features important for the document generation process.

Extensions to Conventional Programming Constructs
Some of the features unique to DGL are:

¢ Verbatim Inclusion—Text may beincluded in atemplate and passed “asis’, i.e. literaly

to the output document segments. Thisis particularly useful for passing formatting
commands to the formatter.

+ Include File—Text from another file may be copied to the output document segments.

¢ Calling External Programs—External programs (e.g., operating system services) may be
called from within the template.

¢ Include Satemate Reports and Plots—Rational Statemate predefined reports and

graphical plots may be included in the document.

Database Extractions

A set of functions can be used to extract database information regarding specific elements and

produce lists of elements according to specified criteria. Database extraction functions and their
use are explained in Documentor Functions.

There are several kinds of functions;

¢ Single-Element Functions—Return element details (as strings, or numbers). Such

functions can be used to return an element name, synonym, type, definition, short
description, or attribute values. Parts of an element’s long description may be retrieved
through the use of keywords.

¢ Query Functions—Retrieve alist of elements having a certain relationship with other

specified elements or having a specified attribute value. For example, you may retrieveall
descendants of a given activity and store themin alist.

¢ Utility Functions—Perform operations and manipulations (e.g. sort) on lists, single

integers and strings.
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Overview of DGL Statements

Hereisabrief overview of DGL statements. Subsequent sections provide you with the full range
of available statements and their syntax. DGL is written as statements, each of which is a specific
command to the Documentor Tool. Thetypes of statements vary, and most are similar to constructs

in other languages.

DGL statements consist of the following types:

¢ Sructure statements—Define the structure of the template.

¢ Declaration statements—Declare the type of identifier for variables, constants and

parameters.

¢ Assignment statement—Assign avalue to avariable.
¢ Filehandling statements—Open or close files or the dialog area, and read data from

files.

¢ Output statements—Pass information to output document segments, or to the dialog

area.

¢ Control flow statements—For conditional and iterating execution of statements.

SEGMENT seg 1;

VARIABLE
CHART ch_id;
INTEGER status;
BEGIN
ch_id:=

| F status = stm_success
THEN
WRITE (‘ThisisaPlot’);
STM_PLOT(ch_id, ‘my_file
ELSE
WRITE('Retrieval failed’ );
END IF;

END;

stm_r_ch (‘CHZ1’ ,status) ;

)

structure statement
declaration statement

structure statement

databqse extraction function in
an assignment statement
control-flow statement

output statement

output statement (plot statement)
control-flow statement

output statement

structure statement

38

Documentor Reference Guide



Data-types and Expressions

Data-types and Expressions

Identifiers are names that are used in atemplate and can represent constants, variables or
parameters. The differences between these are noted here:

¢ Constants are identifiers whose values are constant and cannot be changed in DGL
statements.

¢ Variablesareidentifiers whose values can change in DGL statements.

¢ Parameters are variables whose values may be assigned in a special form before
executing the template.

Before you use an identifier, you must declare whether it is a constant, variable or parameter.
Furthermore, you must declare the particular typeof vaue that can be assigned to the identifier; we
cal thistype adata-type

For instance, an identifier (whether constant, variable, or parameter) may be declared to hold
integervalues, float va ues, string values, etc.

Identifiers can be combined to construct expressions; these can be used in various kinds of
statements and database extraction functions. Various kinds of expressions can be constructed,
depending on the data-types of the identifiers of which they are constituted.

For instance, you may construct numeric or string expressions as well as Rational Statemate
element expressions.

This section deals with both data-types and the expressions you can construct from them. In
addition, enumerated typesariables or return values of afunction that take arestricted number of
discrete vaues, are described.

Data-types

You declare identifiers and their data-types in declaration statements; these are described in later
sections. Below we list the various data types that are recognized in DGL declaration statements.

Conventional Types found in Other Programming Languages

INTEGER (numeric)
FLOAT (numeric)
Boolean

STRING

FILE
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Rational Statemate Element Types

These data-types are Rational Statemate elements. Typically, you use identifiers of thistypein
Rational Statemate database extraction functions. For example:

ACTIVITY ac;
STRI NG ac_nane;

ac : = st mr_ac (ac_name , st);
WRI TE(' activity synonymis ',
stmr_ac_synonyn(ac, st));

The variable ac isdeclared hereto be of type ACTI VI TY.

A database extraction function assignsavauetoac (thevadueisan activity whose nameisthe value of
thevariableac_nane). IntheWR TE statement that follows, ac isused as an argument in another
function that returns the synonym for the activity represented by ac.

There are two kinds of type declarations for Rational Statemate elements:

¢ ELEMENT - thisdeclaration allows you to assign any Rational Statemate element to the
identifier.
¢ Specific Satemate element Types - The following types are recognized:

ACTI ON

ACTI VI TY

A FLOW LI NE
CHART

CONDI TI ON
CONNECTOR
DATA | TEM
DATA_STORE
DATA_TYPE
EVENT

FI ELD

FUNCTI ON

| NFORVATI ON_FLOW
M FLOW LI NE
MODULE

REQUI REMENT
STATE

TRANSI TI ON

The variables having Rational Statemate element data-type hold an ID number which is used for
internal representation.

You may useidentifiers of type ELEMENT in place of using identifiers with specific type declarations.
For instance, in the previous example, we could have legitimately declared the variable ac to be of type
ELEMENT instead of type ACTIVITY.
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However, there are advantages to using specific element type declarations. When you use a
specific element type declaration, identifier assignments and function parameters are checked to
ensure that values are of the proper type. Thisis of particular importance for assignments by
database extraction functions. For instance, in this above example, the function st m r _ac returns
an activity ID that isassigned to ac; if we useac with afunction call that returnsamodule, the
Documentor detectsthis as an error during template compilation. If, however, we had declared ac to be
of type ELEMENT, no syntax error would have been detected.

In some cases, you must declare an identifier to be of type ELEMENT instead of being of a specific
element type. This case comprisesidentifiersthat are assigned valuesfrom alist of elements of mixed
type (i.e., of more than one eement type). For anillustration of this, seethe example below for typeLIST
OF ELEMENT.

LIST OF simple_type

Identifiers declared as LIST OF simple-typeacan be assigned values of aligt of items of any data-type.
Simple-type may be any of the abovetypes (e.g. LIST OF STRING LIST OF ACTIVITY, &tc.).

The following example shows atypical use of identifiers of thistype; in this case, we have
declared an identifier of type LIST OF STATE.

VARI ABLE
LI ST OF STATE sub_st;
STATE st_id;
I NTECER st ;
BEG N
st id:=stmr_st (‘S1' , st) ;
sub_st := stmr_st_logical _sub_of_st({st_id},st) ;
END;

In this example, the variable st _i d isassigned thelD of the sate S1.

Thisvariable is then used with another database extraction function to extract all of the substates
of st _i d and assign their valuesto thevariable sub_st of type LIST OF STATE.
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Expressions

Parameters, variables and constants are used to build expressions, suchasa + 5.

Expressions such as these may be used in assignment statements, in calls to predefined functions,
and in Boolean expressions (comparisons). In addition, functions themselves may participate in
expressions.

Expressions can be constructed for any of the data-types:

¢ NUMERIC: for example, a* (b+3. 2)

¢ STRING: for example, ' DATA- | TEM DI CTlI ONARY’

¢ Boolean: for example, A > B

¢ Satemate element: for example, stmr_ac ( ' AA , st)
¢ LIST:forexample,a_list + b_list

In the following sections, we present a more detailed explanation of the expression types that you
can construct.

Numeric Expressions

These are integer and real numbers. Their constant values are the same as in conventional
programming languages.

Binary operations(+,-,* ,/,** ) and unary operations (- , +) follow conventional precedence
rules.

Numeric expressions may mix integer or real operands.

Parenthesis may be used to change the precedence of operations.
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Boolean Expressions

The basic Boolean expressions are comparisons between expressions of other types. Note that not
al comparisons are legal for all data-types.

Operator Meaning Allowed types
= Equality all
<> inequality all
< Lessthan numeric and lists
<= Lessthan or equal to numeric and lists
> Greater than numeric and lists
>= Greater than or equal to numeric and lists

For LIST types, Boolean comparisons are understood in terms of inclusion. For example, for listsA and
B, A <Bif B containsall dementsof A and also other elements.

The Boolean operations NOT, OR, and AND are also supported.

In addition there are two predefined Boolean constants: TRUE and FAL SE.

String Expressions
String literals are written within apostrophes, for example: * ABC
Spaces within literal strings are always considered. For example,

“A BC’ isdifferent from* ABC . String literals may contain formatting characters using the backdash
character (\ ) character:

¢ \n: insertsanew linein the string.

¢ \t: insertsatabinthestring.

¢ \:the backdash, when followed by any other character, includes that character literally
into the string. Thisis not intended for use with a phanumeric characters but for including
specia charactersin the string - especially \ and’ .

String expressions may include string constants, string variables, and functions that return strings.

Concatenation of stringsis supported; it isindicated by the “+” sign. For example: * str1’ +
"abc’ resultsin ’ strlabc’.
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Rational Statemate Element Expressions

Expressions of this type may be either declared variables or function calls that return a Rational
Statemate element (refer tp Documentor Functions). For example, nd : = stmr_nd (nd_nane ,
st); returnsavalue of type MODULE and assignsit to the variable nd in the assgnment statement.

As another example, consider the following:

stmr_md_synonym (stmr_nd ("M’ , stl) , st2)
Here we use the module extracted by the function st m r _nd asan argument in another function.
There are no constants for Rational Statemate elements. The variables of the above types get their
values via the Rational Statemate predefined functions, and are used as arguments in other

predefined functions to retrieve additional information. Rational Statemate element ID numbersare
used as values of these expressions.

List Expressions

Thistype is used to handle collections of items of any of the DGL types. A list is created either by
explicitly enumerating theitemsin thelist, or asaresult of afunction call. Explicit enumerationis
written as:

{ list_item, list_item, ... }
asinthestringlist: {*abc’, ’'def’, ’xyz'} .
A list item must be an expression of the list type.

All itemsin the list must be of the same type. Lists can be created from other lists using the
operations: union(+), subtraction(-), intersection(*), and concatenatiorf& ).

This last operation differs from unionwhen two identical lists are used, for instance:

{’ Al pha’ }+{’ Al pha’} produces {’ Al pha’},
while{* Alpha’} & {* Alpha’} produces {’ Al pha’,’ Alpha'} .
A list expression can also be built as aresult of afunction. For example,
stmr_md_nanme_of _md ( "M’ , st) .
The value of thislist expression is all modules whose names begin with M

44 Documentor Reference Guide



Data-types and Expressions

Enumerated Types—Predefined Constants

A variable or return value of afunction is considered of enumerated typié it may take aredtricted
number of discrete values. For example, avariablethat representsaday of theweek may have only seven
values, Sunday through Saturday.

DGL does not directly support enumerated types. The way to deal with variables of such atypeis
to declare them as INTEGER, and to define constants that are equal to the specific possible values. In
order to make the template clearer, you may use meaningful namesfor these congtants. For instance, you
may define congtants for the days of the week: SUNDAY:= 1, MONDAY:= 2, and so on.

The Documentor has several sets of predefinecconstants used as enumerated types. The names for
these congtants always begin with the prefix stm .

For example, avery useful enumerated type is Element Type. The possible values for thistype are
stm_statestm_evenEtc; each of these identifiers has aunique integer value.

You may use predefined constants in your template without even knowing their numerical values.
However, you must make sure that variables that are to be assigned enumerated values are
declared as INTEGER.

For example, another widely used predefined enumerated typeis the function return status codsee
Documentor Functions). Status codes have arestricted number of values, each value denoting some
information about the operation of the function being used.

For example, stm_succesdenoting the successful completion of the function operation, correspondsto
the value 0. You do not have to explicitly use the value O when writing this status code into your
template; for insgtance, you can write:

VARI ABLE
| NTEGER status ;

md ("ML’ , status);
1 success THEN

Predefined enumerated types are listed in their relevant sections.
For instance, an enumerated type that isreturned by a certain function islisted in the description of
that function.
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DGL Statements

This section presents the DGL statements and their syntax, along with examples of their use.

Structure Statements

These statements define the structure of the template. There are four statementsthat define the
structure of your template:

¢ TEMPLATE statement—First statement of the template.

¢ SEGMENT statement—Starts a new segment section.

¢ PROCEDURE statement—Starts anew procedure section.

¢+ BEGIN/END statement—Marks the boundaries of atemplate section.
In addition, Comment statements can be used to indicate program comments.

Next is a more detailed discussion of each structure statement.

TEMPLATE Statement
Statement Syntax:

TEMPLATE t enpl at e_nane ;

The TEMPLATE statement isthefirst statement in the template, and assigns an identifying nameto the
template. Thisnameisused for internal documentation purposes only and does not haveto correspond to
the name you use to designate the template in the Create Templatéorm.

SEGMENT Statement
Statement Syntax:

SEGMVENT segnent _nane ;

The SEGMENT gatement starts anew segment section. It isthefirgt satement of asegment, and assigns
anidentifying nameto it. Theidentifier islimited to 16 characters maximum. The segment nameis used
by thetoal in its operation formsto identify the output segments.
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PROCEDURE Statement
Statement Syntax:

PROCEDURE procedure_nane [ RETURN type]

The PROCEDURE statement begins a procedure section. It assigns an identifying name to the procedure
and definesthereturn type, if the function returnsavaue. The procedure nameislimited to 16 characters

maximum.

BEGIN/END Statement
Statement Syntax:

BEG N
statenents
END,

The BEGIN/END statement delineates the bodyof atemplate section. Recall that a section bodycontains
DGL statements to be executed by the program. You may included any number of statements between
BEG N and END.

Comment Statement
Statement Syntax:

- free text

DGL may include programmer comment lines in the template. These are lines of free text that are
not interpreted or handled by the Documentor during execution. Such comments are useful for
documentation purposes.

Comments are preceded by two dashes. The comment symbol may start anywhere in aline, except
within aliteral string. All characters after the comment symbol until the end of theline areignored.

An example of acomment:

- This line contains program coments
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Declaration Statements

You declare identifiers and their data-types in declaration satementsin the declaration part of each
template section.

Declarations for global identifiers and parameters are made in the initiation section - these
identifiers can then be used throughout the template.

Declarationsfor local identifiers, i.e., identifiersto be used only in the relevant segment, are made
after each segment identifier line. Procedures start with declarations of parameters and local
identifiers.

PARAMETER Statement
Statement Syntax:

PARAMETER dat a-type identifier [:= val ue]
For Example:

PARAVETER STRI NG activity_nane ;

There are “template parameters’ for the entire template and “ procedure parameters’ for
procedures. Template parameters are variables whose value may be changed interactively when
the template is executed.

Declaration of template parametersis allowed only in the initiation section. The keyword
PARAMETER appears only once in the declaration section, before the data-type assignments for
parameters. Each data-type statement may be followed by as many identifiers of the same type asyou
want to define.

For Example:

PARAMETER STRI NG activity_name, state_nane, event_nane;
As many type statements as desired may follow the PARAMETER keyword.

For Example:

PARAVETER

STRI NG acti vity_name;
FLOAT a: =3. 243;
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Template parameters may not hold a Rationd Statemate e ement, whileit islegd for aprocedure
parameter to be of thistype. Procedure parameters are In/Out parameters.

Value assignments for PARAMETER gtatements are optiona and allowed only for template parameters
(we made one such assignment in the above example). If it isassgned, it represents the default value of
the parameter at thefirst generation of a particular document. The value may only be aliteral constant,
not a constant identifier or an expression.

Note

Avoid changing template parameters within the template. It may cause confusion and can
create inconsistent results when parameters are changed within segments.

CONSTANT Statement
Statement Syntax:

CONSTANT data-type identifier := value ,
Constants are identifiers that have a defined value that cannot be changed in DGL statements.
The keyword CONSTANT agppearsonly oncein the declaration section, before the data-type assgnments

for congtants. Each datartype statement may be followed by as many identifiers of the sametype asyou
want to define.

For Example:

CONSTANT integer a:=1, b:=2, c:=3;
As many type statements as desired may follow the CONSTANT keyword.

For Example:

CONSTANT
STRING activity_name: =" Print’;
FLOAT a: =3. 243;
| NTEGER c: =6;

The constant type may not be a Statemate elemeiat, a list of type

Theidentifiersin the CONSTANT gtatement must havetheir values assigned in the statement. Thevalue
may be any expression not containing variables or parameters.
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VARIABLE Statement

Statement Syntax:

VARI ABLE data-type identifier [:= value],...
Variables are identifiers whose values may be changed in other DGL statements.
The keyword VARIABLE appears only oncein the declaration section, before the data-type assignments

for variables. Each data-type statement may be followed by as many identifiers of the same type asyou
wish to define.

For Example:

VARl ABLE STRI NG act _nane, act_syn, act_desc;
As many type statements as desired may follow the VARIABLE keyword. For example:

VARl ABLE

string activity_naneg;

float a:=3.243;

activity act_id;
Value assignments are optional (we made one such assignment in the above example). If they are
assigned, they represent the default value of the variable at the first generation of a particular
document. The value may be any expression that does not contain other variables or parameters.

Variables that are declared as Statemate elemerasd list of items may not be assigned initia values.
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Assignment Statement

Statement Syntax:

vari abl e : = expression;
This statement should be interpreted as follows: the variable on the left-hand side of the statement
is assigned the value of the expression on the right-hand side.

The expression and the variable must be of the same or compatible type. If the expression is of
type STATE, ACTIVITY, etc., the variable s of the sametype, or of type ELEMENT.

Here is an example of atemplate with a declaration section, followed by a section containing an
assignment statement.

VARI ABLE
LI ST OF STATE st_list;
LI ST OF ACTIVITY act_list;
LI ST OF ELEMENT el _list;
BEG N

el list := st list + act_list:
END;

File Handling Statements

These statements open and close files or the dialog area, to and from which you can pass text or
messages, through the use of WRITE and READ statements. The READ statement isalso included inthe
file handling statements, whereas the WRITE is consdered to be an output statement.

OPEN Statement
Statement Syntax:

OPEN (fl, file_nane, node [, status]);
wheref | isanidentifier of type FILE and node isether INPUT or OUTPUT.
This statement is used with rode=OUTPUT to open afile or the didog area so that a subsequent

WRITE statement can passtext to it, and with node=INPUT for subsequent READ statements. The
satement assignsavauetof | .

The dialog areais frequently opened to pass run-time messages to it. To open the dialog area, use
the string ‘DIALOG' (with the apostrophes) for thef i | e_nane.

Optionally, you may include the status function code st at us which returnsthe value stm_success
upon successful execution of the statement.
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If the file opened for output does not exist, this statement creates a new file.

If thefile exists, it isinitialized by the OPEN statement; i.e., the written information overwritesthe
exigting contents of thefile.

CLOSE Statement
Statement Syntax:

CLOSE (fl);

wheref| isanidentifier of type FILE. This statement closes afile that was previoudy opened with the
OPEN statement.

READ Statement
Statement Syntax:

READ(fl, variablel, variable2, ...) ;
wheref | isanidentifier of type FILE that pointsto afile that was opened using an OPEN statement, in
INPUT mode. The variables are identifiers of typeinteger, floator string.

Each READ gtatement reads aline from thefile. The numeric eementsin theinput line are separated by
blank or tabs. Reading to astring variable readstherest of theline.

For Example:

READ(fd, i, str)
wherei isaninteger and st r isadgtring. This statement, when gpplied to aninput line: 12 May 1991,
resultsin: i =12, st r ="May 1991'.

The READ statement may operate asafunction that returns either stm_successtm_cannot_read_fijer
stm_end_of file
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Output Statements

Output statements pass text to the output segment files. The text can originate from a number of
sources:. the template itself, user text files, database retrieval functions, Rational Statemate reports
and plots, external programs, and evaluated expressions. Output statements cannot be put in the
initiation section.

Below, we detail the various types of output statements.

Verbatim Statement
Statement Syntax:

/| @verbatimtext @

When the verbatim symbols/ @and @ frametext in thetemplatefile, thetext is passed literaly
(without interpretation) to the output segment file. Commentsinsidethe frame, rather than being ignored,
are passed literdly aswell. The end-of-statement character, “;”, is not required following the concluding
verbatim symbol.

Verbatim statements may be used to pass the following to the output file:

+ Formatting commands applicable to a specific formatter.

+ Short text passages such astitles, opening remarks, etc.
In spite of the absence of any length restriction on verbatim text, longer text passages are
usually passed using the INCLUDE file statement.

For example, when this verbatim section of the template is executed:

SEGVENT sectionl;

BEG N ! @
.title ACTIVITY-SPEC
.skip 2

.center; AN ACTIVITY SPECI FI CATI ON
- This section will describe the
- purpose of the activities.

- this line will not appear in the output
END ;

it resultsin the following output:

title ACTIVITY-SPEC

.skip 2

.center; AN ACTIVITY SPECI FI CATI ON
-- This section will describe the
- purpose of the activities.
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WRITE Statement

Statement Syntax:

WRITE ( [fl,] wite_expression , ... )
The WRITE statement to write expression valuesto any of the following

¢+ The document output segment
+ Another file
¢ Thediaog area of the tool window

You may write anumeric or string expression that is evaluated in the template, or aliteral piece of
text. The WRITE statement can a so be used to write information retrieved from the database, such as
element names.

Using the WRITE statement to writeto afile or to the didog areais particularly useful if you want to
write messages (error messages, run-time messages, etc.). When writing to afile or to the dialog area,
you mugtincludethef | identifier. In such cases you must aso precede the WRITE statement with an
OPEN gtatement.

The WRITE statement is commonly used to write lines that include text (string literals) together with
expression values.

For example: WRI TE(' NAME:’, di _name) ;
resultsin the following being written in the output segment file NAME: KUKU , where KUKU isavaue
of di _nane.

From the examples you can see that there can be more than one write expression. When there are
multiple expressions they are separated by commas.

Lines of puretext are more suitably handled using the Verbatim statement.
Literal strings may include the formatting characters:

\'n - new-line
\t - tab

For example, WRI TE(’ \n’, al pha) ;
would write the value of alphaat the beginning of the next line in the output segment file.

Optionally, you can specify the minimum number of charactersto bewritten in the output file. You
do this by using the following syntax for the write expression:

expression .onum

where expr essi on can be either anumeric or astring expression, and numis an integer constant or
integer expression that represents the minimum number of charactersthat expr essi on will occupy.
expr essi on and nummay involve operands, operations, and function calls.
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For Example:

WRI TE(act _nanme: 10, ’',’ , act_synonym;

results in the string value for act _nane being written in the output file to alength of at least 10
characters, if the name haslessth

Rational Statemate 55



Document Templates

Using WRITE to Produce Messages
A WRITE statement may also be used to write informatianfiie or to the dialog area, instead of to the
document itself. For this, you must first open a fil@wWTPUT mode using th©PENstatement.

To write a string message to tfile use the following syntax:

WRITE (fl, write_expression);
wherefl is the file pointer to whickiou want to write the messages.

INCLUDE Statement
Statement Syntax:

INCLUDE (file_description [, status]);
wherefile_description is either dile-nameor an identifier of typ€ILE.

This statement copies the text cfecified file to an output segmdide. The text is passed to the
file verbatim and may containrimatting commands fdhe format processor that is used to
produce the formatted document.

When thefile_description is afile_name It can be any string expressj it may be &teral string
inside quotes (e.¢ABC’) or an evaluated expression that producéle name (e.g., a variable that
contains a file name).

Note

Thefile_namemay include the directory pathname of the file, using the file name
conventions of the host operating system. lf o not specify the pathname, the Workarea
is searched for the file.When tfile_description is of typeFILE, the file from which you
are copying text mustrét be opened with aDPENstatement iIOUTPUT mode.

When using théNCLUDE statement you may optionally include the status functionstatis
which, upon successful executiortlod statement, returns a valuesioh_success
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EXECUTE Statement
Statement Syntax:

EXECUTE (cal | i ng_sequence);

This statement invokes a program that is external to Rational Statemate. The Documentor searches
for the program name using the regular system search path. The tool then

Rational Statemate 57



Document Templates

Each of the predefined reportsisinvoked for alist of elements. Theinput parameter that represents
thislist is denoted by avariable name that must be of type list
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wi dt h isaninteger argument indicating the page width (in characters) to be used for
the report.
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¢ Attribute Report
stmrpt_attribute(elist, attrs, attr_title) ;

el i st isalist expression of Rational Statemate elements for which the report is
produced.

attrs isalist of strings that contains the specific attribute names for which the
report should be generated. If thislist is empty, then the report retrieves al the
attributes for each element.

attr_titleisastring indicating that the attribute value will precede its element
name in the report.

¢ Interface Report

stmrpt_interface(elist, rtype, chart, |act
I mod, ftype, dis, names) ;

el i st isalist expression, that must be of the type list of modulesfor which the
report is produced.

rtype isasingle character string argument indicating the report type:

— ‘A’ indicates activity interface report.
— ‘M’ indicates module interface report.
— ' I' indicates information interface report.

chart isasingle character string argument indicating which arrows are taken into
account when the report is generated:

— ‘A’ indicates activity-chart arrows.
— ‘M’ indicates the module-chart arrows.

I act isan argument of type list of activitiesindicating which activities are taken
into account when the report is generated. If | act isan empty list, the default is all
activities implemented by the center module.

Note: If chart is‘M’, then this parameter has no function. | act must still be
supplied here. For simplicity, the null list (nul 1 ) may be used.

| mod isan argument of type list of modulesndicating the side moduleghat interface with the
central module for which the report is to be generated. If | nod is empty, the default is all modules
except the center module's own ancestors and descendants.
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ft ype isasingle character string argument indicating the kind of information flow to appear in the
report:
— ‘D’ indicates data-flows.
— 'C’ indicates control-flows.
— ‘B’ indicates both.
di s isasingle character string argument indicating the kind of information to appear
in the report:
— ‘I" indicates flow labels.
— ‘P’ indicates parent information items.
— ‘B’ indicates basic information items.
nanes iSasingle character string argument:

— ‘N’ indicates that the nameappears for elements that flow between the boxes.

— 'S’ indicates that the synonymeppears for elements that flow between the
boxes.

¢ N2Chart Report

stmrpt_n2chart(elist, nanes, |level, env, chart,
dis, ftype)

el i st isalist expression, which must be of the type list of moduleer list of
activities specifying the elementsin the diagonal .
names isasingle character string argument:

— ‘N’ indicates that nameof the elements appear on the diagonal of the matrix.

— 'S’ indicates that synonymsf the elements appear on the diagonal of the
matrix.

I evel isasingle character string argument indicating what appears on the diagonal
when both parent box and sub-box are in the list.

— ‘B’ indicates that sub-boxis placed on the diagonal of the matrix.
— ‘P’ indicates that the parent boxs placed on the diagonal of the matrix.
env isaBoolean expression; if true then the environments added to the matrix.

chart isasingle character string argument indicating which arrows are taken into
account when the report is generated:

— ‘A’ indicates activity-chart arrows.
— ‘M’ indicates the module-chart arrows.
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di s isasingle character string argument indicating the kind of information to appear
in the report:

— ‘I' indicates flow labels.

— ‘P’ indicates information items.

— ‘B’ indicates basic information items.
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st
ti

*

*

mplot (id, file, width, height, with_|abel, with_name, with_note, device,
tle_position, title, do_rotate, with file_header, actual _height)

id - isthe ID number of aRationd Statemate chart to be plotted.

file - isa STRING with the name of the file destination to which the plot is written. The
operating system pathname conventions are followed. You may specify afull pathnameto
any directory for which you have write access. If asimple filenameis specified, theplot is
written to your Workarea. If the parameter isleft empty (‘ * ), the plot isincluded as part
of the output file.

width - isanumeric argument of type FLOAT that indicates the maximum possible width
of the plot (in inches).

height - isanumeric argument of type FLOAT that indicates the maximum possible height
of the plot (in inches).

with_label - isaBOOLEAN parameter which indicates whether arrow labels are (TRUE)
or are not (FALSE) printed in the plot.

with_name- isaBOOLEAN parameter indicating whether box names are (TRUE) or are
not (FALSE) printed in the plot.

with_note-isaBOOLEAN parameter indicating whether notes are (TRUE) or are not
(FALSE) printed in the plot.

Note:
— device isa STRING argument that indicates the plotting device. This may
indicate a supported formatting language if the plot isto be handled by a
formatting processing system that has its own graphics language. To

configure anew plotter or printer (for example, a paper type), select Utilities
> Qutput Devices from the main Rational Statemate menu.

— Plots created using the Word format in the Output Device dialog are RTF
files.

title_position isa STRING parameter indicating where to place the plot title. This
parameter accepts one of the following values:

stm_plt_none - thetitle is not included.
stm_plt_top - thetitle is placed athe top of the plot.
stm_plt_bottom - thettitle is placed a the bottom of the plot.
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¢ titleisa STRING argument that specifies what title will be printed with the plot.

¢ do_rotate isaBOOLEAN parameter where TRUE indicates |andscape and FAL SE
indicates portrait.

with_file_header isaBOOLEAN parameter where TRUE indicates that a header is

to be added at the beginning of thefile. (Usethisif you do not want the plot as part of the
document.)

actual_height isanumeric argument of type FLOAT that indicates the actual height (in
inches) of the plotted output.

Thefollowing is an example of how aplot isgene
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Include Table Statement
Statement Syntax:

stm_table_simple (title, columns, contents, page_width, page_height, anchor);

This statement generates a simple table. You specify the number of columns and their width, and
the information to be included in the table. The parameters are as follows:

+ titleisthetitle of thetable. Thetitle appears centered over the table.

+ columnsisalist of integersthat specify the width of each column in number of characters.
For instance: {16} & {16} & {20} specifies atable having three columns, the first
two columns being 16 characters wide and the last column being 20 characters wide.

+ contentsisalist of strings containing the information to be entered into each cell of the
table. The information fills the table horizontally, row by row, depending on how many
columns were specified. For instance, if you specified three columnsin the columns
parameter, the following contents

{'Project Name'} & {'Date’} & {'Location’} &
{{Alpha’} &{'April 1987’} & {'Boston’}

would produce this table:

Project Name Date Location

Alpha April 1987 Boston

+ pagewidth determinesthe width of the pageininches. It isonly relevant for Interleaf - for
other systems, you may specify 0.0 for this parameter.

+ page_height determinesthe height of the pageininches. It is only relevant for Interleaf -
for other systems, you may specify 0.0 for this parameter.

+ anchor, relevant only for Interleaf. A character string indicates where to place the table.
Theoptionsare‘A’ - a anchor, ‘F - following anchor. The default is*F'.

For formatters other than Interleaf, precede the table with your system’s no fill and no adjust
formatting commands.
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The following is an example of how atable can be generated using function calls. Notice how we
repeatedly assign new valuesto theLi st _st r variableto build the table.
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Control Flow Statements

Several control flow constructs provide you with options for conditional and iterating statement
execution. These resemble constructs in other conventional programming languages.

IF/THEN/ELSE Statement
Statement Syntax:

| F bool ean_expressi on THEN
st atenents
[ ELSE statenents ]
END I F ;
ThelFTHEN/EL SE congtruct is used for conditiona execution of DGL statements.
In this statement, the statements following the THEN (and before any ELSE) are executed if the

bool ean_expr essi on evauatesto true. If it isevauated to fase, the satements following the ELSE
are executed, when present.

Here is an example:

IF a > b THEN
EXECUTE (’ DATE') ;
I NCLUDE (' sanple.txt’) ;
ELSE
WRITE ("a is less than b’) ;
END I F ;

SELECT/WHEN Statement

The SELECT/WHEN construct is used for conditional execution of DGL statements. This statement is
more powerful than the previous IFTHEN/EL SE statement, in that it allows you to systematicdly list
multiple conditions for statement execution.

Statement Syntax:

SELECT [ sel ecti on_node]

VWHEN trigger => statenments
[ WHEN trigger => statenents ]

[ VWHEN ANY => statenents ]

[ VWHEN trigger => statenents ]
[ WHEN ANY => statenents ]

[ OTHERW SE => statenents ]
END SELECT ;
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The optionakelection_mode  can be either the keywoFtRST or ANY The selection-mode
determines the way the statements are checked fdblpassicution - this wilbe explained shortly. The
default selection-mode IBRST.

Note thatwHEN statements are composed of two partstridger  to the left of the arrow, and
statements  on the right side of the arrow. The triggeaisy valid Boolean expssion. The statements
following a trigger are performed only when thgder is true. Whether or not these statements are
actually executed also depengt®n the selection-mode, as follows:

If the selection-mode iBNY then the statements are axed whenever their corresponding
trigger is true.

If the mode iFIRST (or not given), then only the first true trigger in the er8EeECT
construct is executed; the rast ignored, regardless of whettiezir triggers are true or not.

TheWHEN ANYstatements are executed when one or more of the preeddiEgtatements
have been executed.

The OTHERWISEtatements are executed only iWWBENtatement within thBELECT
construct is triggered.

To demonstrate the execution of 8&_ECT/WHENconstruct, consider the following example
andc are numeric variables.

SELECT ANY

WHENa=5=>b:

10;

WHENa>b=>b:=10;

WHENa=0=>b:=0;

WHEN ANY => write ('a may influence b’) ;

WHENc=5=>b:=5;

WHENc>b=>b:=5;

WHENc=0=>b:=0;

WHEN ANY => write ('c may influence b’) ;

OTHERWISE => write ('b has not been changed’) ;
END SELECT;

The execution is determined by:

1.
2.

EachwHENMNtatement is triggereéfits corresponding expressi is evaluated to true.
The firstWHENANY statement is triggeredadfis equal to 5, greater thanor equal to zero.

The secondVHENANYstatement is triggeredat least one of these sanmnditions is true with
respect to the variabte instead of.

The OTHERWISBtatement is triggered only if the valuébdias not been changed within the
SELECTstatement’s evaluation.

When processing WHENANY statement, the Documentor Toolly “looks back” to the previous
WHEN ANY construct (if one exists). Theoeg, in the above exampleaif= 0 and none of the testsof
were true, th®VRITE statement’s messagenayinfluence b is not issued.
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In this example, what would happen if the selection mode was FI RST instead of ANY, and the
conditions a>b and c =5 wereboth true?

Inthiscasetheassignment b: = 10 andthefirst write message (the corresponding WHEN ANY
datement) are executed. The assignment of b to 5 along with its corresponding WHEN ANY statement are
not done because ¢ = 5 isnot thefirst true trigger.

The statements following the => symbol in the WHEN constructs may be any valid DGL statements.
You may even enter a SELECT construct at this point. Thisalowsyou to nest SELECT constructs. There
isno limit to the depth of nested SELECT blocks.

FOR/LOOP Statement
Statement Syntax:

FOR identifier INIlist LOOP
st atenents
END LOCP ;

The FOR/LOOP congtruct is used for iterative execution of DGL statements. The statements after the
keyword LOOP are executed for each eement in the specified | i st .

Alternatively, arange of integers can be specified in place of thel i st , asin thefollowing example:
FORi IN{1..100} LOOP

statenent ;

END LOOP :

Thei denti fi er isavariablewhosevalueis sat sequentidly to theitemsin thelist. Thetype of the
i denti fier must matchthetypeof thel i st . Thisvariable may be used within the body of the loop.

The following 